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Models Covered By This Reference

This Hardware Reference includes information on the following AT-9800 Series 
switches:

■ AT-9812T

■ AT-9812TF

■ AT-9816GB

■ AT-9816GF

The latest AT-9800 Series Hardware Reference can be found at 
www.alliedtelesyn.co.nz/support/9800/.

Why You Should Read This Reference

This Reference provides hardware related information for AT-9800 Series 
switches.

The Reference has two primary aims:

1. To familiarise you with the hardware features of AT-9800 Series switches.

2. To assist you with setting up and maintaining your AT-9800 Series switch. 

Step by step instructions for installing AT-9800 Series switches can be found in 
the AT-9800 Series Quick Install Guide.

Keep this Reference (or its CD-ROM) in a safe place, you will need it if you purchase 
switch expansion options (such as CAM or DIMM) in the future.

This Reference does not cover software configuration or software installation 
procedures. For information on software, refer to the AT-9800 Series Software Reference.

CAM

AT-9800 Series

Printed Acrobat PDF Website

Documentation Roadmap

Safety and Statutory Information Booklet

Software Reference

Hardware Reference

General Customer Support

Visit www.alliedtelesyn.co.nz for 
the latest documentation, FAQs, 
and support information.

Quick Install Guide

CAM Quick Install guide
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Where To Find More Information

The Documentation and Tools CD-ROM bundled with each switch contains the 
complete Document Set for AT-9800 Series switches and their expansion 
options, as well as tools for switch management. This includes:

■ The AT-9800 Series Safety Booklet, which provides safety and statutory 
information.

■ The AT-9800 Series Quick Install Guide, which outlines the procedure for 
installing switch units; and this AT-9800 Series Hardware Reference.

■ The AT-9800 Series Software Reference, which provides detailed information 
on configuring the switch and its software.

■ The CAM Quick Install Guide, which outlines the procedure for installing 
Content Addressable Memory.

■ AT-TFTP Server for Windows, for downloading software releases.

■ Adobe Acrobat Reader, for viewing online documentation.

■ Netscape Communicator.

■ Microsoft Internet Explorer.

These documents can also downloaded from the AT-9800 Series Support Site at 
www.alliedtelesyn.co.nz/support/9800/.

Hardware Description

This section provides an overview of hardware features for the AT-9800 Series, 
as well as hardware descriptions of each model. 

Switch Overview
Developed to meet the exceptionally high performance demands of high end 
applications, AT-9800 Series switches deliver hardware-based low-latency 
high-bandwidth wire speed Layer 2 and 3 switching in a robust 1.5U platform.

With GBIC and 10/100/1000BASE RJ-45 port options bridging traditional 
copper/fibre divides, and hardware expansion options such as CompactFlash, 
CAM and DIMM, the AT-9800 Series is a versatile and powerful switching 
solution for rapidly evolving networks.

CompactFlash operation will be supported by future software releases. Contact your 
authorised Allied Telesyn distributor or reseller for more information.

Dimensions

• Height = 66 mm (plus 5.5 mm if the rubber feet are used)

• Width = 440 mm (excluding rack-mounting brackets)

• Depth = 360 mm

• Weight = Not more than 6.6 kg, depending on model (excluding power 
cord)
C613-03043-00 REV B
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Mounting System

• 1.5U rack mounting

Environmental Conditions

• Operating temperature range: 0 to 40º C (32 to 104º F)

• Storage temperature range: -25 to 70º C (-13 to 158º F)

• Relative humidity range: 5 to 95% non-condensing

Regulatory Standards

• EMC: EN55022 class A, FCC class A, and VCCI class I

• Immunity testing to EN55024: EN61000-4 levels 2 (ESD), 3 
(susceptibility), 4 (fast transients), 5 (power surge), 6 (RF immunity), 
and 11 (Voltage dips and sags; EN61000-3 levels 2 (Harmonics), and 3 
(Flicker)

• Safety: UL60950, CSA22.2 No. 950-M95, EN60950, ACA TS001

LEDs

• Port and System status LEDs

• For a complete list of LEDs and their functions, see “LEDs and What 
They Mean” on page 24.

Power Supply Unit

AC models

• Universal 110/240 VAC 50/60 Hz input

• Redundant DC Power connection

DC models

• 48 V DC (39-60 V DC is acceptable)

• Accepts positive or negative earthing (grounding)

Switching Core

• ASIC switch chip

• Non-blocking L2 and L3 IP Switching

• 40 k-entry forwarding address database (expandable to 232 k-entries 
with LineCAM)

• 64 MByte RAMBUS packet buffer

Processing Core

• 300 MHz RISC Processor

• 128 MBytes Synchronous DRAM (expandable to 256 MByte with 
DIMM)

• 16 MBytes of fixed flash 

• CompactFlash slot for hot swappable expansion of flash up to 512 
MBytes (to be supported by future software releases)

• 512 kBytes of Non-volatile SRAM (NVRAM)
C613-03043-00 REV B
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• Battery backed real time clock (RTC)

• 32/66 PCI bus.

• Silicon ID chip storing serial number, board ID, and MAC address

Asynchronous Serial Port

• Up to 115 kbps

• Universal Asynchronous Receiver Transmitter (UART)

• Standard DB9 female RS-232 connector

• Hardware-flow control

AT-9800 Series Switch Models
This section provides hardware descriptions for individual switch models. 

AT-9812T
(Figure 1 on page 5)

• 12-port 10BASE-T/100BASE-TX/1000BASE-T (RJ-45 connectors)

• 4-port 1000BASE-X (GBIC slots)

• Unrestricted 1000BASE-T GBIC use

• CompactFlash slot

• One DIMM socket for expansion of Synchronous DRAM

• One CAM socket for expansion of the forwarding address database 

• Compatible with AT-PWR9000 RPS systems (AC models)

• Auto-negotiating Layer 3 Managed Switch

 Figure1: Front panel of the AT-9812T.

AT-9812TF
(Figure 2 on page 6)

• 12-port 10BASE-T/100BASE-TX/1000BASE-T (RJ-45 connectors)

• 4-port 1000BASE-X (GBIC slots)

• Unrestricted 1000BASE-T GBIC use

• CompactFlash slot

• One DIMM socket for expansion of Synchronous DRAM

• One CAM socket for expansion of the forwarding address database 

• Compatible with AT-PWR8000 RPS systems (AC models)

• Auto-negotiating Layer 3 Managed Switch

STATUS

RESET

FAULT

PWR

RPS

13

15

14

16

1

7

2

8

3

9

4

10

5

11

6

12

13 14

15 16 1  2  3  4 5  6  7  8 9  10  11  12

RS-232
TERMINAL PORT

L /A

D/C

L /A

D/C

L /A

GBIC

L /A

GBIC

ASYN0

1000BASE-X GBIC

10BASE-T / 100BASE-TX / 1000BASE-T

AT-9812T
Multi-Layer Gigabit Switch

PORT ACTIVITY

ACT1000M L /A

ACT10/100M 

COL

FULL DUP 

HALF DUP 

D/C

FAULT

ACTLINK / FULL DUP  L /A

ACTLINK / HALF DUP

DISABLED

ENABLED GBIC

GBIC BASE-T



6 AT-9800 Series
 Figure2: Front panel of the AT-9812TF.

AT-9816GB
(Figure 3 on page 6)

• 16-port 1000BASE-X (GBIC slots)

• Unrestricted 1000BASE-T GBIC use

• CompactFlash slot

• One DIMM socket for expansion of Synchronous DRAM

• One CAM socket for expansion of the forwarding address database 

• Compatible with AT-PWR9000 RPS systems (AC models)

• Layer 3 Managed Switch

Figure 3: Front and rear panels of the AT-9816GB.

AT-9816GF
(Figure 4 on page 7)

• 16-port 1000BASE-X (GBIC slots)

• Capacity for up to six 1000BASE-T GBICs

• CompactFlash slot

• One DIMM socket for expansion of Synchronous DRAM

• One CAM socket for expansion of the forwarding address database

• Compatible with AT-PWR8000 RPS systems (AC models) 

• Layer 3 Managed Switch
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Figure 4: Front and rear panels of the AT-9816GF.

Online Documentation

This section provides a step-by-step guide to accessing online documentation. 
Adobe Acrobat Reader must be installed to view the online documentation.

To Access Online Documentation

To use the CD-ROM, follow these steps:

1. Insert the Documentation and Tools CD-ROM in the CD-ROM drive.

2. If the Welcome screen does not appear.

Select "Run" from the Start Menu (Windows 95, 98, 2000 or NT 4.0).

Type d:\start.exe (where d: is the CD-ROM drive letter) and click OK.

3. To view a document.

Click on the document title.

4. To navigate around PDF documents.

Use the toolbar buttons, keyboard shortcuts, or commands from the 
Document menu to page through the document.

Click on a bookmark, thumbnail or hypertext link to jump to a specific 
section or topic.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select 
"Reader Guide" from the Help menu.

5. To install any of the tools included on the CD-ROM.

Click on a link in the Welcome screen. 
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AT-TFTP Server

This section provides information on how to access and use AT-TFTP Server. 
AT-TFTP Server can be used to transfer configuration files as well as to 
download software patches and releases.

To use AT-TFTP Server, follow these steps:

1. If AT-TFTP Server has not yet been installed.

Install it now from the AT-9800 Series Documentation and Tools CD-ROM.

Choose AT-TFTP Server from the Start > Programs > Allied Telesyn > AT-
TFTP Server menu.

2. To set preferences for the AT-TFTP Server.

Select "Options" from the File menu to display the "Set Preferences" dialog 
box.

The "Default file transfer directory" field specifies the directory that AT-
TFTP Server will read from or write to for file requests that do not include a 
directory specification.

To prevent unauthorised access to private directories, enter a path name in 
the "Restrict to directory" field. AT-TFTP Server will use only the specified 
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to 
archive scripts created using the switch's CREATE CONFIG command, 
select "Read Write".

Make any required changes and click "OK".

3. To load a file from AT-TFTP Server to the Switch.

On a terminal connected to the RS-232 Terminal Port (ASYN0), type the 
command:

LOAD METHOD=TFTP FILE=filename SERVER=ipadd DEST=FLASH

where filename is the name of the file to download and ipadd is the IP 
address of the PC running AT-TFTP Server.
C613-03043-00 REV B
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4. To save a TFTP Server log.

Select "Save As" from the File menu.

TFTP requests are logged to the AT-TFTP Server main window.

Using Windows Terminal and Windows 
Hyperterminal

You can use a PC running terminal emulation software as the manager console, 
instead of a terminal. There are many terminal emulation applications 
available for the PC, but the most readily available are the Terminal and 
HyperTerminal applications included in Microsoft Windows 95, 98, 2000, and 
Windows NT 4.0. In standard Windows installations, HyperTerminal is located 
in the Start > Programs > Accessories menu.

The key to successful use of terminal emulation software with the switch is to 
configure the software and switch with matching communications parameters. 
The following procedures describe how to configure Windows Terminal and 
HyperTerminal for the default RS-232 ASYN0 settings on the switch, but the 
same principles apply to other terminal emulation programs.

To configure Windows HyperTerminal for Windows 95, 98, 2000, & NT 4.0.

1. In Windows, select:

• Programs > Accessories > HyperTerminal.

• Double-click the Hypertrm.exe icon.

2. In the Connection Description dialog box:

• Enter a name for the connection (e.g., AT98001)

• Select an icon from the scrolling list.

• Click “OK”.

3. In the Phone Number dialog box:

From the “Connect using:” drop-down list, select:

• “Direct to Com n” Where “COM n” is the COM port on the PC used to 
connect to the switch.

• Click “OK”.
C613-03043-00 REV B
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4. In the COMn Properties dialog box, set:

• Bits per second: 9600.

• Data bits: 8.

• Parity: None.

• Stop bits: 1.

• Flow control: Hardware.

• Click “OK”.

5. From the File menu, select:

• “Properties”

In the Connection Properties dialog box, click the Settings tab and set:

• “Function, arrow, and ctrl keys act as” to “Terminal keys”

• “Emulation” to VT100.
C613-03043-00 REV B
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6. Click “ASCII Setup” to display the ASCII Setup dialog box. Uncheck:

• “Echo typed characters locally”.

• “Append line feeds to incoming line ends”.

Set other parameters as required.

• Click “OK” twice to close all dialog boxes.

7.  Save the current session. From the File menu, select:

• “Save”.

This creates a connection icon with the name you assigned in the 
HyperTerminal group. To use the configuration:

• Double-click the connection icon in the HyperTerminal group.

When the HyperTerminal window appears, press:

• [Enter] a couple of times.

The switch’s log in prompt will appear.

Switch Start-up

This section outlines the log in and start-up procedures for your switch. 
Although the switch will perform basic switching operations without being 
configured, you will need to go through these log in and start-up procedures if 
you wish to configure the switch and access its full layer 3 switching 
capabilities.

To log In
To log in you must first connect the switch to a terminal or PC. This can be 
done using the RS-232 Terminal Port (ASYN0). A terminal cable suitable for 
use with ASYN0 is supplied with each switch.

Using the supplied terminal cable, or a cable you have made by following the 
instructions in “Useful Cables” on page 16, connect your terminal or PC to 
ASYN0.
C613-03043-00 REV B
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Set the communication parameters on your terminal or terminal emulation 
program to:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: Hardware

See “Using Windows Terminal and Windows Hyperterminal” on page 9 
for more information on configuring emulation software.

Ensure that any power switches are in the On position and that the switch 
is receiving power. 

After the switch has booted, the log in prompt appears. If the log in prompt 
doesn’t appear, press [Enter] two or three times.

When the switch boots for the first time it automatically creates an account 
with manager privileges. The account has the log in name “manager” and 
the password is “friend”.

At the log in prompt, enter the log in name and password.

Log in: manager

Password: friend

The switch’s command prompt appears and you can now configure the 
switch using the command line interface.

Change the password as soon as possible. Leaving the manager account with 
the default password is a serious security risk. Make sure that you remember 
the new password as there is no way to retrieve it if it is lost.

Use the following command to change the account password:

set password

See the AT-9800 Series Software Reference for more information on 
configuring the switch.

To access help

Before help can be accessed, the help files must be defined. To define the files, 
enter:

set help=help-filename

where help-filename is the name of a help file stored in flash.

To see a list of files stored in flash, enter:

show file

Help files have an HLP extension.

To display a list of help topics, enter:

help

To display help on a specific topic, enter:

help topic

Alternatively, type a question mark (?) at the end of a partially completed 
command to see a list of valid options.
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Start-up Procedures
When the switch starts up following either a power cycle or an operator-
initiated reboot (using the Reset button or RESTART command), a series of 
start-up messages is sent to the terminal or PC connected to ASYN0 (Figure 5 
on page 13).

Figure 5: Switch start-up messages.

After the self tests are complete, the manager is given the option of forcing a 
mandatory boot from the EPROM (Flash) release. The message:

Force EPROM download (Y)?

is displayed on the terminal or PC connected to ASYN0 and the switch pauses. 
If a key is not pressed within a few seconds, the start-up process will continue 
and all steps in the sequence will be executed. Pressing selected keys on the 
terminal immediately after the “Force EPROM download” message is 
displayed will change the switch start-up process (Table 1 on page 13).

During the start-up process the switch will generate four different types of 
messages. All messages are preceded by one of the words INFO, PASS, FAIL, 
or ERROR. The significance of these words is shown in Table 2 on page 13.

INFO: Self tests beginning.
INFO: RAM test beginning.
PASS: RAM test, 131072k bytes found.
INFO: BBR tests beginning.
PASS: BBR test, 512k bytes found.
INFO: Self tests complete
INFO: Downloading switch software.
Force EPROM download (Y) ?
INFO: Initial download succeeded
INFO: Executing configuration script <boot.cfg>
INFO: Switch startup complete

Manager >

Table 1: Switch start-up sequence keystrokes.

Pressing key... Forces the switch to...

[Y] Load the EPROM release, with no patch.

[S] Start with the default configuration. Any boot script is ignored.

[Ctrl/D] Enter diagnostics mode.

Table 2: Switch start-up message classes.

Message Meaning

INFO An action will be taken by the system.

PASS A test has been completed successfully.

ERROR An error message that a test has failed, but the system will continue to 
operate.

FAIL An error message that a fatal error condition has caused the system to 
halt in an unrecoverable fashion.
C613-03043-00 REV B
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The possible messages and their meanings are:

INFO: Self tests beginning.

The code loader tests are about to begin.

INFO: RAM test beginning.

The RAM tests are about to begin.

PASS: RAM test, 65536k bytes found.

The RAM test passed, and the indicated amount of memory was found 
and will be used by the switch.

ERROR: RAM test 5. Error address = 00345678.

A RAM test failed, at the given address. In the example, it was the fifth 
test run. The RAM test repeats until it passes, so a number of messages 
like this may appear. This fault means that the memory system is faulty. 
If the fault continues, contact your Authorised Allied Telesyn 
distributor or reseller immediately.

INFO: BBR tests beginning.

The BBR battery tests are about to begin.

PASS: BBR test. Battery OK.

The BBR battery tests passed.

ERROR: BBR Battery low.

The BBR battery test failed, indicating that the battery is running low. 
The BBR battery will need to be replaced. Contact your Authorised 
Allied Telesyn distributor or reseller.

PASS: BBR test, 512k bytes found.

The BBR size/location test passed, with the indicated amount of BBR 
found.

FAIL: BBR test. Error address = 12345678.

The BBR size/location test failed at the given location. The test at this 
location failed, indicating the end of memory, but a valid location was 
discovered in the 255 long words following this location. The BBR 
system will need to be replaced. Contact your Authorised Allied 
Telesyn distributor or reseller.

FAIL: BBR test, only 16k bytes found.

The BBR size/location test completed, but only the displayed amount 
of memory was found. This amount is less than the minimum required 
to run the switch software.

INFO: Self tests complete.

The start-up tests have finished.

INFO: Downloading switch software.

The process of downloading the switch software and vector table from 
ROM is about to begin.

ERROR: Code load retried.

FAIL: Code load failed.

The load of the code from ROM to RAM failed. The load is retried a 
number of times. Each time a failure occurs, the ERROR message is 
displayed. If the maximum number of attempts is reached, the FAIL 
message is displayed.
C613-03043-00 REV B
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INFO: Initial download succeeded.

The start-up tests and download are complete, and the switch software 
is about to be started. If the default install is a compressed release, the 
release will now be decompressed. This may take a few seconds.

INFO: Downloading compressed release. This may take up to 1 
minute...

INFO: Loading software into memory. This may take up to 1 
minute...

The main switch software is about to be loaded into RAM. If the release 
is a compressed release, the release will be decompressed.

INFO: Executing configuration script <script-name>

The configuration commands stored in <script-name> are being 
executed. If an error is found in the script, one or more ERROR 
messages will be displayed.

INFO: Switch startup complete.

The start-up process is complete and the switch will now perform basic 
switching operations. Further configuration will be necessary if you wish to 
access the switch’s full layer 3 switching capabilities. See the AT-9800 Series 
Software Reference for detailed information on configuring the switch.

RS-232 Terminal Port (ASYN0)

This section introduces the switch’s RS-232 Terminal Port (ASYN0), including 
its pin assignment and purpose.

The RS-232 ASYN0 Terminal Port is used to connect the switch to a 
management device for initial configuration and switch management tasks. 
This allows the switch’s software to be accessed from a terminal, a PC running 
terminal emulation software, or from a remote location via a modem 
connection. You can also use ASYN0 to establish a network connection from a 
remote site using SLIP and a modem.

ASYN0 has a DCE female socket. This allows the use of a straight-through 
cable when connecting the switch to a terminal or PC. Output from the SHOW 
ASYN command will, however, still have a DTE perspective. The internal DTE 
pin roles are listed in Table 3 on page 16.

See “Useful Cables” on page 16 for more information on suitable cables to use 
with ASYN0. 

Figure 6: RS-232 Terminal Port Pin Numbers.

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female   Pin View
C613-03043-00 REV B



16 AT-9800 Series
Useful Cables

This section describes how to make management, test, and network cables for 
use with the switch’s RS-232 (ASYN0) and RJ-45 interfaces. 

RS-232 Terminal and Modem Cables
Table 4 on page 16 list the terminal and modem cables described in this section. 

Figure 7 on page 17, and Figure 8 on page 17 show how to wire cables to 
connect a standard VT100 compatible terminal, or a modem, to ASYN0.

Table 3: Internal DTE pin roles.

Pin Role

2 TXD

3 RXD

4 CD

5 GND

6 DTR

7 CTS

8 RTS

9 (Not used)

Table 4: Terminal and modem cable descriptions.

Cable type Description

RS-232 DB9 male to female terminal cable Figure 7 on page 17

RS-232 DB9 male to male modem cable Figure 8 on page 17
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Figure 7: Pin wiring diagram for a standard DB9 male to female terminal cable.

Figure 8: Pin wiring diagram for a DCE RS-232 Terminal Port (DB9 female 
connector) male to male modem cable.

More information on pin assignments for the RS-232 Terminal Port can be 
found in “RS-232 Terminal Port (ASYN0)” on page 15.

Notes:
(1) → Output from switch; ← Input to switch.
(2) Cable version 1.0.

DB9MDB9Fsw

1 
2 
3 
4 
5
6
7
8
9

1
2
3
4
5
6
7
8
9

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female   Pin View
Pin 6 Pin 9

Pin 1 Pin 5

DB9 Male   Pin View

DB9 Male 
(to switch/DCE)

DB9 Female
(to PC/terminal/DTE)

Not connected
→ (TXD)
← (RXD)
← (CD)
    (GND)
→ (DTR)
← (CTS)
→ (RTS)
← (RING)

(DCD)
(RXD)
(TXD)
(DTR)
(GND)
(DSR)
(RTS)
(CTS)
(RING)

Notes:
(1) → Output from switch; ← Input to switch
(2) Cable version 1.0.

DB9MDB9Fsw

 
3 (TXD) 
2 (RXD) 
1 (DCD) 
5 (GND)
4 (DTR)
8 (CTS)
7 (RTS)
9
6 Not connected

1
2
3
4
5
6
7
8
9

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Male   Pin View
Pin 6 Pin 9

Pin 1 Pin 5

DB9 Male   Pin View

DB9 Male 
(to switch/DCE)

DB9 Male
(to modem/DCE)

Not connected
→ (TXD)
← (RXD)
← (CD)
    (GND)
→ (DTR)
← (CTS)
→ (RTS)
     (RING)
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Cables for RJ-45 Ethernet LAN Interfaces
For 10BASE-T/100BASE-TX/1000BASE-T (10/100/1000BASE) connections, a 
twisted pair cable with four pairs and RJ-45 connectors must be used. 

Table 5 on page 18 lists the cables used for network connections and testing of 
RJ-45 interfaces.

Caution. Do not plug a phone jack into any RJ-45 port. Doing so could damage 
the switch. Use only twisted pair cables with RJ-45 connectors.

Pin assignments
For twisted pair cables each pair is identified by two different colours. For 
example, one wire might be red, and the other red with a white stripe. An RJ-45 
connector must be fitted to both ends of the cable. Figure 9 on page 18 
illustrates the pin layout for RJ-45 connectors.

Figure 9: RJ-45 Pin layout. 

1000BASE straight through cable
For 1000BASE network connections, all four pairs are used and the cable is 
wired in a straight-through configuration. This cable can also be used, in 
conjunction with the software test facility, to test 1000BASE network ports. 
Table 6 on page 18 lists the pin assignments.

Table 5: Cables for RJ-45 LAN interfaces.

Purpose Interface type Cable type Pairs Pin assignment

Network 10/100/1000BASE Straight through Four Table 6 on page 18

Test 10/100/1000BASE Crossover or straight through Four Table 7 on page 19 or 
Table 6 on page 18

Table 6: Pin assignments, 10/100/1000BASE-T RJ-45 four pair straight-through 
cable.

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 1+

2 Pair 1- 2 Pair 1-

3 Pair 2+ 3 Pair 2+

6 Pair 2- 6 Pair 2-

4 Pair 3+ 4 Pair 3+
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1000BASE crossover cable
For 1000BASE test cables, all four pairs are used and the cable is wired in either 
a crossover or straight-through configuration. Table 7 on page 19 lists the pin 
assignments for a crossover cable.

Test Facility

This section introduces the Test Facility. The Test Facility is built into all 
AT-9800 Series software. For detailed information on operating the Test Facility, 
see the Test Facility chapter of the AT-9800 Series Software Reference.

Any interfaces being tested are dedicated to the Test Facility. The Test Facility 
can be thought of as a specialised interface module like PPP or Frame Relay.

Before using the test facility, disable any configurations (SET 
CONFIGURATION=NONE) and restart or reboot the switch.

Ethernet LAN Port Tests
A crossover cable is required to run an Ethernet LAN test. See “Useful Cables” 
on page 16 for details of how to make a suitable cable. To start the test, loop a 
four-pair crossover or straight-through cable between any two RJ-45 ports and 
enter:

ENABLE TEST INT=ALL

5 Pair 3- 5 Pair 3-

7 Pair 4+ 7 Pair 4+

8 Pair 4- 8 Pair 4-

Table 7: Pin assignments, 10/100/1000BASE-T RJ-45 four pair crossover 
cable .

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 2+

2 Pair 1- 2 Pair 2-

3 Pair 2+ 3 Pair 1+

6 Pair 2- 6 Pair 1-

4 Pair 3+ 4 Pair 4+

5 Pair 3- 5 Pair 4-

7 Pair 4+ 7 Pair 3+

8 Pair 4- 8 Pair 3-

Table 6: Pin assignments, 10/100/1000BASE-T RJ-45 four pair straight-through 
cable. (Continued)

End 1 End 2
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A loopback plug, instead of a crossover cable, can be used to test SC and MT-RJ GBIC 
interfaces.

All interfaces connected by crossover cables are tested. Test results are 
displayed with the command:

SHOW TEST

which produces a display like that shown in Figure 10 on page 20. A more 
detailed output (with frame counts) can be displayed with the command:

SHOW TEST COUNT

which is shown in Figure 11 on page 21.

Figure 10: Example output from the SHOW TEST command, with a test cable between ports 1 and 4.

Board      ID  Bay Board Name                      Rev    Serial number
----------------------------------------------------------------------------
Base      157      AT-9812TF                       P1-0   42029694

                                              Duration       Details
Interface  State    Result              Type  (minutes)  Data( %OK )  Control
----------------------------------------------------------------------------

  port1   testing   wait 4 minutes      TP         < 1   GOOD (100.0)  -
  port2   no test     -                  -           -    -     -      -
  port3   no test     -                  -           -    -     -      -
  port4   testing   wait 4 minutes      TP         < 1   GOOD (100.0)  -
  port5   no test     -                  -           -    -     -      -
  port6   no test     -                  -           -    -     -      -
  port7   no test     -                  -           -    -     -      -
  port8   no test     -                  -           -    -     -      -
  port9   no test     -                  -           -    -     -      -
  port10  no test     -                  -           -    -     -      -
  port11  no test     -                  -           -    -     -      -
  port12  no test     -                  -           -    -     -      -
  port13  no test     -                  -           -    -     -      -
  port14  no test     -                  -           -    -     -      -
  port15  no test     -                  -           -    -     -      -
  port16  no test     -                  -           -    -     -      -

  asyn0   testing   wait 4 minutes       -         < 1    -     -      -
----------------------------------------------------------------------------
C613-03043-00 REV B



Hardware Reference 21
Figure 11: Example output for the SHOW TEST COUNT command, with a test cable between ports 1 and 4.

Other Interface Tests
Refer to the Test Facility of the AT-9800 Series Software Reference for information 
on testing other interfaces.

If a test fails, please contact your Authorised Allied Telesyn distributor or reseller.

Redundant Power Supply (RPS)

RPS units enhance network reliability by providing backup coverage for switch 
Power Supply Units (PSUs).

AC models of AT-9800 Series switches have an RPS connector on their rear 
panel. The connector allows the switch to be used in conjunction with an RPS. 
DC models do not have an RPS connector.

AT-9812TF and AT-9816GF models can be used with AT-RPS8000 systems, 
while AT-9812T and AT-9816GB models can be used with AT-RPS9000 systems. 
RPS systems can be purchased separately.

Board      ID  Bay Board Name                      Rev    Serial number
----------------------------------------------------------------------------
Base      157      AT-9812TF                       P1-0   42029694

                          Duration                   Frame Counters
Interface  State    Type  (minutes)         Tx    RxTotal     RxGood      RxBad
--------------------------------------------------------------------------------

  port1   testing   TP         < 1   000298842  000298841  000298841  000000000 
  port2   no test    -           -           -          -          -          -
  port3   no test    -           -           -          -          -          -
  port4   testing   TP         < 1   000298842  000298841  000298841  000000000 
  port5   no test    -           -           -          -          -          -
  port6   no test    -           -           -          -          -          -
  port7   no test    -           -           -          -          -          -
  port8   no test    -           -           -          -          -          -
  port9   no test    -           -           -          -          -          -
  port10  no test    -           -           -          -          -          -
  port11  no test    -           -           -          -          -          -
  port12  no test    -           -           -          -          -          -
  port13  no test    -           -           -          -          -          -
  port14  no test    -           -           -          -          -          -
  port15  no test    -           -           -          -          -          -
  port16  no test    -           -           -          -          -          -

  asyn0   testing    -         < 1   000000000  000000000  000000000  000000000
--------------------------------------------------------------------------------
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AT-RPS8000
The AT-RPS8000 is a chassis that holds up to four removable AT-PWR8000 RPS 
units. To provide backup power to AC versions of AT-9812TF and AT-9816GF 
switches, each switch must be connected to an AT-PWR8000 RPS unit, and the 
RPS unit must be installed in an AT-RPS8000 chassis.

Table 8 on page 22 lists the RPS connector’s pin numbers and pin functions, as 
found on AT-9812TF and AT-9816GF switches.

Table 9 on page 22 illustrates the connector’s pin layout, as found on the rear 
panel of AT-9812TF and AT-9816GF switches.

Pin 16 is at the connector’s top left, while pin 1 is at its lower right.

Table 8: RPS Connector Pin Numbers and Functions.

Pin Number Function

1 +12V DC

2 Remote Sense (RS) +5V DC

3 Remote Sense (RS) Ground

4 Remote Sense (RS) +3.3V DC

5 Redundant Power Supply (RPS) Present

6 Ground (+3.3V DC Return)

7 Ground (+5V DC Return)

8 +5V DC

9 Ground (+12V DC Return)

10 +3.3V DC

11 Ground (+3.3V DC Return)

12 +3.3V DC

13 Ground (+3.3V DC Return)

14 +3.3V DC

15 +5V DC

16 Ground (+5V DC Return)

Table 9: AT-PWR8000 RPS Connector Pin Layout.

16 15 14 13 12 11 10 9

8 7 6 5 4 3 2 1
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AT-RPS9000
The AT-RPS9000 is a chassis that holds up to four removable AT-PWR9000 RPS 
units. To provide backup power to AC versions of AT-9812T and AT-9816GB 
switches, each switch must be connected to an AT-PWR9000 RPS unit, and the 
RPS unit must be installed in an AT-RPS9000 chassis.

Table 8 on page 22 lists the RPS connector’s pin numbers and pin functions, as 
found on AT-9812T and AT-9816GB switches.

Figure K-1 on page 23 illustrates the connector’s pin layout for AT-9812T and 
AT-9816GB switch models.

Figure K-1: AT-RPS9000 connector (on the switch’s rear panel).

Table 10: AT-PWR9000 RPS Connector Pin Numbers and Functions.

Pin Number Function

A1 5V DC

A2 Ground (5V DC, 3.3V DC, 12V DC)

A3 3.3V DC 

1 Redundant Power Supply (RPS) Present

2 Remote Sense (RS) +3.3V DC 

3 +12V DC

4 RPS Fan Signal

5 Ground (5V DC In, 3.3V DC, 12V DC)

6 Remote Sense (RS) +5V DC 

7 Remote Sense (RS) Ground

8 +12V DC In

9 Not Used

10 Ground (5V DC In, 3.3V DC In, 12V DC)

A1 A2 A3

6    7   8   9   10

1    2   3   4    5

ClayRpsConn
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Port, Connector, and Cable Combinations

This section provides cabling guidelines for each switch model.

1. Refer to the IEEE 802.3 standards for further cable information.

Troubleshooting 

This section provides information on how to detect and resolve problems with 
AT-9800 Series switches and their expansion options.

Other sources of useful troubleshooting information are:

■ www.alliedtelesyn.co.nz/support/9800/.

■ The AT-9800 Series Software Reference.

LEDs and What They Mean
The following tables outline how LEDs on AT-9800 switches report faults and 
operational activities. 

Table 11: Cable guidelines for AT-9800 Series switches.

Model Port Type Connector Type Cable Type1 Maximum Cable Length

AT-9812TF 10BASE-T/100BASE-TX/
1000BASE-T

RJ-45 CAT5

CAT5E

100 to 150m

(328 to 492ft)

200m (656ft)

AT-9816GB
AT-9812TF

1000BASE-X Varies with GBIC Refer to GBIC’s user 
documentation

Refer to GBIC’s user 
documentation
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System LEDs 

1.   DC models of AT-9800 Series Switches do not have an RPS connector and the RPS LED will not 
function.

Table 12: System LEDs found on all AT-9800 Series Switches.

LED State Function

PWR 

(Power)

Green The switch is receiving power

Fault Red The switch or management software is 
malfunctioning

1 Flash A switch fan has failed or is operating below 
the recommended speed 

2 Flashes If RPS monitoring is enabled, an RPS fan has 
failed or is operating below the recommended 
speed

3 Flashes If an RPS is connected, the switch’s PSU (Power 
Supply Unit) has failed

4 Flashes If RPS monitoring is enabled, the RPS PSU has 
failed

5 Flashes If RPS monitoring is enabled, an RPS is not 
connected or is not operational

6 Flashes The switch’s temperature has exceeded the 
recommended threshold

RPS1 (Redundant 
Power Supply)

Green An RPS is connected to the switch and is 
receiving power

CompactFlash 
Activity

(Rear panel)

Green The CompactFlash memory is active. Do not 
eject the flash memory module.
C613-03043-00 REV B



26 AT-9800 Series
AT-9812T and AT-9812TF LEDs

AT-9816GB and AT-9816GF LEDs

Table 12: Port and GBIC LEDs on the AT-9812TF.

LED State Function

GBIC L/A

(Link activity)

Green A 1000 Mbps link is open. The link is operating 
in full duplex mode

Flashing green 1000 Mbps full duplex activity is occurring

Amber A 1000 Mbps link is open. The link is operating 
in half duplex mode

Flashing amber 1000 Mbps half duplex activity is occurring

GBIC Green A GBIC is installed and enabled

Amber A GBIC is installed but is disabled

Flashing amber A GBIC is installed and enabled, but a Tx fault 
is occurring

BASE-T L/A

(Link activity)

Green A 1000 Mbps link is open

Flashing green 1000 Mbps activity is occurring

Amber A 10/100 Mbps link is open

Flashing amber 10/100 Mbps activity is occurring

BASE-T D/C

(Duplex/collision)

Green The port is operating in full duplex mode

Amber The port is operating in half duplex mode

Flashing amber Collisions are occurring

Table 13: GBIC LEDs on the AT-9816GB.

LED State Function

GBIC L/A

(Link activity)

Green A 1000 Mbps link is open. The link is operating 
in full duplex mode

Flashing green 1000 Mbps full duplex activity is occurring

Amber A 1000 Mbps link is open. The link is operating 
in half duplex mode

Flashing amber 1000 Mbps half duplex activity is occurring

GBIC Green A GBIC is installed and enabled

Amber A GBIC is installed but is disabled

Flashing amber A GBIC is installed and enabled, but a Tx fault 
is occurring
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Check these first
1. Check the power cord connections.

2. Check that the power supply voltage is stable.

3. Check that the correct data cables are being used and that their connections 
are secure.

4. Check that any GBICs are correctly installed and that they are compatible 
with the switch. Some switch models have limitations on the number of 
GBICs that can be installed. See “Gigabit Interface Converters (GBICs)” on 
page 28 for more information.

5. Make sure that other network devices are working properly.

6. Use the SHOW INSTALL command to check that the latest software release 
is loaded. See the AT-9800 Series Software Reference for more information 
about obtaining the latest software release.

7. If the switch is malfunctioning, reboot it by pressing the recessed Reset 
button or entering the command RESTART REBOOT. 

Some common problems and how to solve them

Link/Activity LED on Any Port is Off

This can indicate:

■ A loose data cable.

■ The device at the other end of the connection is not working properly or is 
turned off.

■ The data cable is not wired correctly.

■ The network administrator has manually disabled the port through the 
software.

■ The port’s selected transmission mode does not match that of the attached 
device.

Perform the following steps in sequence:

1. Make sure the data cable connections are secure.

2. Make sure the device at the other end of the connection is switched on and 
working properly.

3. Check that the data cable is wired correctly.

4. If you can, log in and check the port status. See “To log In” on page 11 for 
more information on how to log in.

5. If the port is Enabled, make sure the transmission speed matches that of the 
connected device (auto-negotiating, full or half-duplex).

If the port is disabled, someone has used the software to manually disable it. You should 
find out why the port was disabled before enabling it.
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Power LED is OFF

This can indicate:

■ A loose power cord.

■ A power supply failure.

Perform the following steps in sequence:

1. Check that the power cord connections are secure.

2. Check that all switches and circuit protection devices are in the ON position.

3. Ensure that the supply voltage is within the operational range (110/240 
VAC 50/60 Hz for AC models, 39-60 V DC for DC models).

Fault LED is on

This can indicate:

■ There is a problem with the switch or PSU.

■ The switch or management software is malfunctioning.

■ A hardware fault is preventing switch start-up.

Perform the following steps in sequence:

1. Check “LEDs and What They Mean” on page 24 for descriptions and 
explanations of LED flashing sequences.

2. Reset the switch by pressing the recessed RESET button on the front panel.

3. If you were attempting to download software or manage the switch via the 
RS-232 Terminal Port, check that connections between the Terminal Port 
and local terminal or PC are secure.

If you cannot access the switch’s software because of a faulty RS-232 
Terminal Port connection, you can still manage the switch via Telnet or 
SNMP until the problem is fixed.

4. Download the latest software release. See the AT-9800 Series Software 
Reference for more information on how to obtain the latest software release.

Expansion Options

This section provides an overview of the expansion options for AT9800 Series 
Switches. The following expansion options were available when this Reference 
was written. See your Authorised Allied Telesyn distributer or reseller, or visit 
www.alliedtelesyn.co.nz/support/9800/ to see if any new options are 
available.

Gigabit Interface Converters (GBICs)
GBICs are removable gigabit port converters for switches that have GBIC bays. 
GBICs allow users to interchange port types to meet changing network 
requirements. RJ-45 copper, and SC and LC fibre GBICs are currently available. 
GBICs can be purchased when a switch is purchased, or can be ordered 
separately as needed.
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Only tested and approved 5V Ethernet GBICs should be used with the AT-9800 
Series switches. 

Any combination of copper and fibre GBICs can be installed in the following 
AT-9800 Series switches:

• AT-9812T

• AT-9812TF

• AT-9816GB 

For the AT-9816GF, up to fourteen 1000BASE-T GBICs can be installed. The 
actual number depends on the number of fibre GBICs also installed. Table 13 
on page 29 lists the number of 1000BASE-T GBICs that can be installed in the 
AT-9816GF for various copper/fibre combinations.

A range of GBICs have been tested and approved for use with the AT-9800 Series, 
contact your authorised Allied Telesyn distributor or reseller for more information, or 
visit www.alliedtelesyn.co.nz.

RX and TX terminal locations on SC fibre GBIC ports are the reverse of TX and RX 
terminal locations on fixed SC fibre ports. When looking at an SC fibre GBIC from the 
front, the RX terminal is on the left and the TX terminal is on the right.

GBIC 1000BASE-T Auto-Negotiation
1000BASE-T GBICs support only 1000 Mbps full duplex connections. Although 
1000BASE-T GBICs will participate in auto-negotiation processes, they will 
only advertise 1000 Mbps. Half duplex, 10BASE-T, and 100BASE-TX modes are 
not supported.

Table 13: GBIC configurations for the AT-9816GF.

Number of fibre GBICs installed Number of 1000BASE-T GBICs installed

0 14

1 13 

2 12 

3 11

4 or 5 10

6 9

7 8

8 7 

10 or 11 5

12 4

13 3 

14 2

15 1

16 0
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While 1000BASE-T GBICs will auto-negotiate at the copper Ethernet level, the 
ports will behave as if in fixed 1000 Mbps full duplex mode. This is because the 
SERDES connection used by GBIC ports makes the auto-negotiation invisible 
to the switch, and so prevents a successful link negotiation.

When a 1000BASE-T GBIC is inserted into a GBIC slot, the port’s auto-
negotiation capability is disabled. This means that the port speed may not be 
set to "auto-negotiate". If the port had been configured to auto-negotiate (by 
default or by command) prior to the GBIC’s insertion, then this configuration is 
overridden for as long as the GBIC remains in place.

CompactFlash
AT-9800 series switches have a CompactFlash slot on their rear panel. Future 
software releases will support flash memory expansion and file transfer 
through via CompactFlash cards. 

Content Addressable Memory (CAM)
LineCAM is a plug-in module that extends the switch’s forwarding database. 

One type of LineCAM is available, a 192 k-entry module. Adding a LineCAM 
module extends the switch’s Layer 2/Layer 3 forwarding database from 40 k-
entries to 232 k-entries. One LineCAM module can be installed in each AT-9800 
series switch.

LineCAM can be ordered as a pre-installed item when purchasing a switch, or 
can be purchased separately and installed as needed.

LineCAM can also be installed in some SwitchBlade line cards.

To check how much CAM is installed, enter

SHOW SWITCH

For information on installing CAM, see “Restricted Procedures” on page 31.

Dual In-line Memory Modules (DIMMs)
Synchronous DRAM for AT-9800 Series switches is provided by a single 
DIMM. Two memory sizes are supported, 128 MBytes and 256 MBytes. 

Only Allied Telesyn supplied DIMMS have been tested and approved for use 
with AT-9800 Series switches. Using DIMM that has not been approved may 
cause unreliable operation and will invalidate the switch’s warranty.

To check how much DIMM is installed, enter

SHOW SWITCH

For information on installing DIMM, see “Restricted Procedures” on page 31.
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Restricted Procedures

This section contains procedures that should only be performed by authorised 
service personnel. Unauthorised use of procedures in this section may cause 
danger of injury from electric shock, damage to the switch, and invalidation of 
the product warranty. 

If you would like to know more about the procedures outlined in this section, 
please contact your authorised Allied Telesyn distributor or reseller.

Installing CAM

LineCAM is available as a 192 k-entry module. Adding a LineCAM module 
extends the switch’s Layer 2/Layer 3 forwarding database from 40 k-entries to 
232 k-entries. One LineCAM module can be installed in each AT-9800 series 
switch.

LineCAM can be ordered as a pre-installed item when purchasing a switch, or 
can be purchased separately and installed as needed.

For AT-9800 Series switches, CAM should only be installed by authorised 
service personnel. Unauthorised opening of the switch’s lid may cause danger 
of injury from electric shock, damage to the switch, and invalidation of the 
product warranty. 

To install LineCAM in an AT-9800 series switch:

1. Avoid injury by working in a safe environment.

The workspace should be free of hazards, and there should be sufficient 
room to lay out the switch, CAM, and tools.

2. Unpack the CAM in an antistatic environment.

Do not attempt to install any hardware without observing correct antistatic 
procedures. Failure to do so may damage the switch or CAM. If you are unsure 
what the correct procedures are, contact your authorised Allied Telesyn 
distributor or reseller.

3. If fitted, disconnect the switch’s redundant power supply.

4. Disconnect the mains power cord.

Before removing the switch’s lid, the power cord and, if connected, RPS power 
cord should be disconnected to reduce risk of electrical shock.

5. Remove all interface cables.

6. Remove the switch’s lid.

The switch may need to be removed from any rack mounting system 
before its lid can be removed.
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Using a posidrive screwdriver, remove the 12 screws that secure the 
switch’s lid. There are 5 screws located in countersunk holes on each side 
of the lid, and 2 screws at the rear. 

7. Align the CAM.

Position the CAM over the CAM slot on the switch’s PCB. The three 
support pillars located on the board should be aligned with the holes on 
the CAM, and the CAM’s chamfers should be pointing to the switch’s PSU 
(see Figure 14 on page 32).

Figure 14: AT-9800 Series CAM slot and pillar mounts.

8. Insert the CAM.

Forcing a misaligned CAM will damage the CAM’s connector and CAM slot.

Press the CAM firmly into place. Secure the CAM to the support pillars 
using the supplied screws. 

The CAM is now ready to test.

Testing CAM
To check that the switch has recognised the CAM, turn on the switch and enter 
the command:

SHOW SWITCH

to display system information, including the amount of CAM installed (see 
Figure 15 on page 33 and Figure 16 on page 33). 

If there is no entry for the CAM, or the entry displays an unexpected value, 
then the switch has not correctly detected the CAM’s presence. The most likely 
cause is that the CAM is not correctly plugged into the CAM slot. Repeat the 
installation process, paying particular attention to the CAM alignment and 
insertion steps.

CAM mounts

Switch chip

CAM slot

BatteryCompact Flash

DIMM slot

CPU

PAC slots

clayPCBPorts

Correct CAM 
orientation

Chamfers

PAC pillars
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Use the SHOW SWITCH command again, and if the display is still not correct, 
contact your authorised Allied Telesyn distributor or reseller.

Figure 16: Example output from the SHOW SWITCH command for a 9800 Series switch with upgraded CAM.

If any CAM test fails, check that the CAM is correctly installed in its slot and repeat the 
tests. Contact your authorised Allied Telesyn distributor or reseller if the CAM does not 
operate correctly.

Figure 15: Example output from the SHOW SWITCH command for a 9800 Series switch with standard CAM (no 
external CAM).

 Switch Configuration
---------------------------------------------------------------------------
 CAM size ( entries ) ....... 40960
 Switch Address ............. 00-00-cd-05-01-0f
 Learning ................... ON
 Ageing Timer ............... ON
 Number of Fixed Ports ...... 16
 Number of Uplink Ports ..... 0
 Mirroring .................. DISABLED
 Mirror port ................ None
 Ports mirroring on Rx ...... None
 Ports mirroring on Tx ...... None
 Ports mirroring on Both .... None
 Number of WAN Interfaces ... 0
 Name of Interface(s) ....... -
 Ageingtime ................. 300
 VLAN classification ........ To be defined
 UpTime ..................... 00:00:03
 Hashingfiled ............... L2 L3 L4
 ---------------------------------------------------------------------------

 Switch Configuration
---------------------------------------------------------------------------
 CAM size ( entries ) ....... 204800
 Switch Address ............. 00-00-cd-05-01-0f
 Learning ................... ON
 Ageing Timer ............... ON
 Number of Fixed Ports ...... 16
 Number of Uplink Ports ..... 0
 Mirroring .................. DISABLED
 Mirror port ................ None
 Ports mirroring on Rx ...... None
 Ports mirroring on Tx ...... None
 Ports mirroring on Both .... None
 Number of WAN Interfaces ... 0
 Name of Interface(s) ....... -
 Ageingtime ................. 300
 VLAN classification ........ To be defined
 UpTime ..................... 00:01:21
 Hashingfiled ............... L2 L3 L4
 ---------------------------------------------------------------------------
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Installing DIMM
AT9800 Series switches have one DIMM slot. The slot can be populated with 
either a 128 MByte DIMM or a 256 MByte DIMM.

Only Allied Telesyn supplied DIMMS have been tested and approved for use 
with AT-9800 Series switches. Using DIMM that has not been approved may 
cause unreliable operation and will invalidate the switch’s warranty.

For AT-9800 Series switches, DIMM should only be installed by authorised 
service personnel. Unauthorised opening of the switch’s lid may cause danger 
of injury from electric shock, damage to the switch, and invalidation of the 
product warranty. 

To install DIMM in an AT-9800 series switch:

1. Avoid injury by working in a safe environment.

The workspace should be free of hazards, and there should be sufficient 
room to lay out the switch, DIMM, and tools.

2. Unpack the DIMM in an antistatic environment.

Do not attempt to install any hardware without observing correct antistatic 
procedures. Failure to do so may damage the switch or DIMM. If you are unsure 
what the correct procedures are, contact your authorised Allied Telesyn 
distributor or reseller.

3. If fitted, disconnect the switch’s redundant power supply.

4. Disconnect the mains power cord.

Before removing the switch’s lid, the power cord and, if connected, RPS power 
cord should be disconnected to reduce risk of electrical shock.

5. Remove all interface cables.

6. Remove the switch’s lid.

The switch may need to be removed from any rack mounting system 
before its lid can be removed.

Using a posidrive screwdriver, remove the 12 screws that secure the 
switch’s lid. There are 5 screws located in countersunk holes on each side 
of the lid, and 2 screws at the rear. 

7. Prepare the DIMMs.

In an antistatic environment, remove the DIMM from its packing material. 
Be sure to observe ESD precautions.
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Do not attempt to install DIMM without observing correct antistatic 
procedures. Failure to do so may damage the DIMM and switch. If you are 
unsure what the correct procedures are, contact your authorised Allied Telesyn 
distributor or reseller.

8. To remove an existing DIMM.

Before removing the switch’s lid, the power cord and, if connected, RPS power 
cord should be disconnected to reduce risk of electrical shock.

The DIMM is held in place by two retaining latches, one latch at each end 
of the DIMM slot. Release these latches and carefully pull the DIMM from 
the DIMM slot.

The DIMM slot’s location is shown in Figure 17 on page 35.

Figure 17: AT-9800 Series DIMM slot.

9. Align and insert the first DIMM.

Holding a DIMM at an angle of about 30 degrees from horizontal, align the 
notches on its connector strips with the notches on an empty DIMM slot 
(see Figure 18 on page 36).

Insert the DIMM into the DIMM slot, sliding it along the two DIMM 
guides until the retaining latches automatically click into place. The latches 
should hold the DIMM firmly in place.

CAM mounts

Switch chip

CAM slot

BatteryCompact Flash

DIMM slot

CPU

PAC slots

clayPCBPorts

Correct CAM 
orientation

Chamfers

PAC pillars
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Figure18: Installing DIMM.

Testing DIMM
The switch is unlikely to boot unless the DIMM is correctly installed. If the 
switch does boot but you suspect the DIMM is malfunctioning, enter the 
command:

SHOW SYSTEM

to display the system information shown in Figure 19 on page 37. In the 
output’s memory section there should be an entry showing the size of DRAM. 
If the DRAM size is less than the size of DIMM that has been installed, then the 
switch has not correctly detected the DIMM. The most likely cause is that the 
DIMM connector is not plugged into its slot correctly. Repeat the installation 
process, paying particular attention to the DIMM insertion step.

After repeating the installation, use the SHOW SYSTEM command again, and 
if the display is still not correct, contact your authorised Allied Telesyn 
distributor or reseller.

If you have any difficulty with the DIMM at any time, contact your authorised Allied 
Telesyn distributor or reseller and quote the serial numbers of both the base card on the 
switch and the DIMM. The switch’s serial numbers and revision details can be read 
using the SHOW SYSTEM command. It’s a good idea to record this information for 
later reference.

DIMM

DIMM slot

Ports

CAM slot
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Figure 19: Example output from the SHOW SYSTEM command for an AT-9800 Series switch, showing DRAM.

Diagnostics
The switch software includes a set of diagnostic programs. These programs 
perform basic level checks of all system components. They do not run in 
conjunction with the normal operating code, and require that the system be 
totally dedicated to their use. A detailed knowledge of the way the switch 
hardware functions is necessary if diagnostics are to be used effectively.

The switch will not perform switching operations if diagnostics are running.

This section is not intended as a guide to the diagnostics software. Diagnostics 
are designed to be run by service personnel only. For more information, contact 
your Authorised Allied Telesyn distributor or reseller.

Switch System Status                            Time 11:25:50 Date 28-Mar-2002.
Board      ID  Bay Board Name                      Rev    Serial number
--------------------------------------------------------------------------------
Base      156      AT-9816GF                       M1-1   46709354
--------------------------------------------------------------------------------
Memory -   DRAM : 65536 kB    FLASH : 15360 kB
--------------------------------------------------------------------------------
SysDescription
Allied Telesyn AT-9816GF version 2.4.0-00 22-Aug-2001
SysContact

SysLocation

SysName

SysDistName

SysUpTime
3382 ( 00:00:33 )
Software Version: 2.4.0-00 22-Aug-2001
Release Version : 2.4.0-00 22-Aug-2001
Release built   : Mar 28 2002 at 00:20:31
Patch Installed : NONE
Territory       : usa
Help File       : help.hlp

Main PSU        : On          Main Fan        : On
RPS Monitor     : Off
Current Temperature : 29 Celsius

Configuration
Boot configuration file: Lucy.cfg (exists)
Current configuration: snoopy.cfg

Security Mode   : Disabled

Warning (2048283): No patches found.
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To enable diagnostics mode:

1. Connect a terminal to the RS-232 Terminal Port (ASYN0).

Using a terminal cable, connect a terminal to the RS-232 Port (ASYN0) on 
the switch. See “Useful Cables” on page 16 for more information on 
terminal cables.

Set the terminal communication parameters to the following:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: Hardware

2. Restart the switch.

Restart the switch, either by using a pen or pencil to operate the recessed 
reset button on the switch’s front panel, or by using the terminal to log in 
and enter the command:

RESTART REBOOT

See “To log In” on page 11 for more information on how to log in.

3. Enable diagnostics mode during start-up.

During the switch start-up process, at the prompt:

Force EPROM download (Y)?

press [Ctrl/D] on the terminal to enter diagnostics mode. A banner page will 
be displayed on the terminal (Figure 20 on page 38). This can be used to 
check that the terminal is correctly connected.

Performing a Full Flash Test or erasing flash will delete all configuration and 
release files. Make sure you know how to reload these files before erasing flash 
or performing a flash test.

Figure 20: AT-9800 Series diagnostics banner page.

To run a diagnostic program, enter the corresponding letter or number (or key). 
There are several sub-menus to cover all the available options. Table 14 on 
page 39 lists the control keys for diagnostic operations.

* * * Diagnostic Mode * * *

  version 16-Mar-98
  
Main Menu:
  0. Restart
  1. Full RAM test
  2. ROM checksum test 
  3. Full FLASH test
  4. Totally Erase FLASH
  5. Battery backed RAM test
Enter selection ==>
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A reasonable understanding of the system’s structure is needed to operate 
diagnostics and interpret the results.

To restore the switch to normal operation, use a pen or pencil to operate the 
recessed reset button on the front panel, or press “0” (zero) to restart.

Contacting Us

Allied Telesyn Offices and Locations

Table 14: Basic commands for running the diagnostics.

Key Function

Q Quits any running tests and displays the banner page.

S Prints a summary of test results so far.

UNITED KINGDOM
Tel: (+44) 1235 442500
Fax: (+44) 1235 442590
SWEDEN 
Tel: 08 131414
NORWAY 
Tel: 2211 1181
DENMARK 
Tel: 3332 3006
FRANCE
Tel: (+33) 01 60 92 15 25
Fax: (+33) 01 69 28 37 49

BELGIUM 
Tel: (+32) 2 481 60 60
Fax: (+32) 2 463 17 06

GERMANY
Tel: (+49) 30 435 90 00
Fax: (+49) 30 435 706 50

GERMANY - SOUTH
Tel: (+49) 8161 99 060
Fax: (+49) 8161 99 0622

EAST EUROPE - AUSTRIA
Tel: (+43) 1 8762441
Fax: (+43) 1 8762572

ITALY
Tel: (+39) 02 416047
Fax: (+39) 02 419282

SPAIN
Tel: (+34) 91 5591055
Fax: (+34) 91 5592644

U.S.A. 
Fax: (425) 489-9191
http://www.alliedtelesyn.com

CANADA
Tel: (905) 709-7444
Fax: (905) 709-7400

LATIN AMERICA
Tel: 1-425-481-3852
Fax: 1-425-489-9191

SINGAPORE
Tel: (+65) 6383-3832
Fax: (+65) 6383-3830

AUSTRALIA
Tel: (+61) 2-9438-5111
Fax: (+61) 2-9438-496

NEW ZEALAND
Tel: (+64) 3 339 3000
Fax: (+64) 3 339 3001
http://www.alliedtelesyn.co.nz
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